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Remark Office OMR 

Tutorials 

Tutorial Overview 

We want you to be immediately successful with your new software. To that end, we highly 

recommend that you walk through the tutorials provided here before you do anything else with your 

new software. The following sections contain the tutorials, which are designed to give you an 

overview of the Remark Office OMR software and allow you to quickly learn the basic functions of the 

software. Two of the most common uses for Remark Office OMR are surveys and tests; therefore we 

have covered both form types in these tutorials. Completing these lessons will help position you for 

mastering the software. Please keep in mind that even though you may only currently do one or the 

other (surveys or tests), completing both tutorials will still help you understand basic software 

premises. We recommend starting with Tutorial I and then continuing with Tutorial II to get the 

broadest knowledgebase (the first tutorial provides more detailed instructions and explanations than 

the second tutorial). 

• Tutorial I – Test (Generic Test Answer Sheet): The first tutorial outlines how to create a 

form template for a test and includes coverage of both basic and advanced options. The first 

tutorial also covers reading tests and grading the test data.   

• Tutorial II – Survey (Hospital Stay Evaluation): The second tutorial outlines how to create a 

form template for a basic survey as well as read forms, correct the output and run reports.  

Important Note: The tutorials provided with the software work with image Files that 
are included when you install Remark Office OMR. In reality, the software can read 
Pages directly from a scanner, or read scanned image Files from other sources, such as a 
multi-function printer (MFP). Even though you are reading pre-scanned image Files, the 
steps you are taking are very similar to scanning directly in the software. If you process 
your own forms directly with a scanner, you choose the options to scan instead of read 
from images within the software. The tutorials still give you a good overview of how the 
software works in order to prepare you for using your own forms and scanner. 

Please note that we have included copies of the tutorial forms in Microsoft Word format 
for your reference. Each document installs to its corresponding tutorial folder, typically 
in your My Documents folder under Remark Office OMR. These forms are not meant to 
be scanned in order to perform the tutorials; images of pre-scanned forms are supplied 
for this purpose. However, you may find it useful to view or print the forms before you 
do the tutorials as reference.  
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The following information details what is accomplished in each tutorial: 

Tutorial 1 – Test 

▪ Creating the test answer sheet form template 

o Creating a barcode region 

o Creating an OCR region 

o Creating OMR regions 

▪ Processing completed tests 

▪ Reviewing and correcting data output with Review Exceptions  

▪ Saving the test data 

▪ Grading tests, including the use of bonus and subjective points 

▪ Saving a grade report  

Tutorial II – Survey 

▪ Creating the hospital stay evaluation form template 

o Creating an OCR region 

o Creating OMR regions 

o Creating linked OMR regions 

▪ Processing completed course evaluation forms 

▪ Reviewing and correcting data output with Review Exceptions 

▪ Saving the hospital stay evaluation data 

▪ Analyzing the hospital stay evaluation data 

o Using Report Batches  

There are some basic concepts to review before you get started with the tutorials. Please note that 

there are several ways to access basic software functions. Three of the most common methods 

include: 

• Task Pane: The task pane on the left side of each Remark Office OMR window can be used to 

access the most common functions in the software. The Task Pane automatically updates 

based on the functions you perform. You can show or hide the task pane by selecting the 

View menu and then clicking Task Pane. 

• Toolbar: The toolbar is the series of icons across the top of each Remark Office OMR 

window. These icons represent shortcuts for common functions within the software.  

• Menus: The pull-down menus have all of the functions available within the software. Many of 

these functions can also be found in the toolbar and task pane. 

It is up to you to decide how you wish to access software functions. We will work with all three 

methods to allow you an understanding of each method.  

Before we begin, we need to touch briefly on some important concepts that may be new to you. Just 

take in the big picture for now; details will be built as these concepts are used in the lessons. 
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Form Template Overview 

The following concepts are explained in greater detail in the Remark Office OMR user’s guide, but are 

important to understand in performing these tutorials. Here is a quick overview to help you get 

started: 

What is a Form Template File?   

The first thing you do in Remark Office OMR (after you have a form created outside the software) is 

create form templates for the forms you wish to process in the software. A form template File contains 

the information needed to instruct Remark Office OMR about each form. The form template conveys 

the location of the information on the Pages (e.g. the bubbles the respondents darken) and the 

specifics of the data you require. The form template defines the backend database you use for 

storage of the processed data. You create a form template for each form that you wish to process 

using the software.  

How are Form Templates Created? 

Form templates are created by scanning an unmarked copy of the form (or importing a scanned 

image of the blank form) to create an equivalent image in the Remark Office OMR Template Editor. 

You then use the mouse to drag boxes (called regions) around the marks (e.g. bubbles) and other 

areas you want to have recognized on your form. These regions tell the software where each piece of 

information you want to capture is located on the Page and other pertinent information about the 

form. They also tell the software what type of data you need the software to output from each area.  

 

You are now ready to get started with the tutorials.  
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Tutorial I – The Test Answer Sheet   

The Test Answer Sheet tutorial is designed to provide you with experience in the basic and a few 

advanced functions of creating a form template and processing forms. The following procedures 

describe how to set up a form template for the sample Test Answer Sheet form included with the 

software. Subsequent sections of this tutorial detail how to process forms and export or analyze the 

data.  

The form template creation process consists of: 

• Scanning an unmarked copy of the form (or importing an image of a previously scanned copy 

of the form) 

• Dragging boxes around the areas to be recognized 

• Providing Remark Office OMR with information about the data you need to collect  

Important Note: As stated previously in the tutorial overview, the tutorials provided with the 
software work with image Files that are included when you install Remark Office OMR. Even 
though you will be reading pre-scanned image Files, the steps you are taking are very similar to 
scanning directly in the software. The tutorials still give you a good overview of how the 
software works in order to prepare you for using your own forms and scanner. 

Creating the Form Template 

The first step in this process is to create a form template outlining the areas on the form that you 

want the software to recognize. 

 

To begin the Test Answer Sheet form template 

1. If not already running, start Remark Office OMR (Start|Programs|Remark Office OMR|Remark 

Office OMR Data Center). 

2. Begin a new form template. Select the File menu and then click New Form Template. 

Alternatively, in the left-hand panel, known as the Task Pane, select New from the Templates 

tab. Any of these actions will open a second window containing the Remark Office OMR 

Template Editor.  

Tip: If you use File|New Form Template or the New link in the Task Pane, the 
Template Editor opens with the new form template window already opened for you.  

3. [Optional] If the Template Editor opens but you do not see the Properties - Form Template 

(New) window, select the File menu and then click New Form Template. 

The Properties - Form Template (New) window opens. This window is where you describe your form 

to Remark Office OMR. You do this by entering basic information about your form, including the form 

template description, Page size and Page orientation.  

4. Enter Test Answer Sheet in the Description box.  
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5. Locate the Page size area where you can tell 

the software the size paper your form uses. If 

not already selected, select US Letter in the 

Size drop-down list.  

6. Locate the Page orientation area and select 

Portrait. 

7. Click the Capture Image button to continue.  

The Create Page Elements window appears. The 

Create Page Elements window allows you to either 

acquire an image of your form from your scanner, 

or acquire an image of your form from an existing 

image File. Each Page in a form template is created using an image of the appropriate Page in your 

form. The image allows you to see the form so that you can easily teach Remark Office OMR how to 

read it.  

   

To obtain a form template image 

As previously mentioned, there are two ways to acquire an image for a form template Page. Images 

can be acquired by scanning to create a new image File or by opening an existing image File. We will 

be acquiring our image from a pre-scanned image File stored on your computer. 

 

1. Click the button for Read Images in the Image 

Collection Method area. 

2. Click the Browse button. The Select Image File 

window opens.  

3. Select the Tutorial 1 – Test Answer Sheet.tif 

File from the Tutorial 1 folder of your Remark 

Office OMR installation directory (e.g. 

Documents\Remark Office 

OMR\Tutorials\Tutorial 1) and then click the 

Open button. 

Once an image is acquired by opening an existing image File, the Template Editor displays a 

thumbnail of the image for your approval. 

4. When a thumbnail image of your form appears, click the OK button to accept the image.  

Once the thumbnail image is accepted, the Template Editor opens the new form template where you 

can begin to define the regions. You see a tree view (item list) on the left and an image representation 

of your form on the right.   

 

To define form template regions   

The purpose behind making a form template is to tell the software where to locate the information on 

your specific form and how to understand your specific data requirements. The following table lists 

the six regions on the Test Answer Sheet form and their corresponding region types: 
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Area on Form Corresponding Region Type 

Student Name OCR 

Teacher Name Barcode 

Questions 1-50 (2 regions) OMR (Multiple) 

Bonus Question OMR (Multiple) 

Official Use Only (used as subjective region) OMR (Grid) 

 

To define the Student Name as an OCR region 

The first area of the form to define is the Student Name, which is defined as an OCR (optical character 

recognition) region. OCR involves reading computer-generated text (not handwriting). In this case, the 

test answer sheets were printed with each student’s name on them before they were distributed. 

Using OCR allows you to quickly collect each student’s name and then use this information on 

subsequent grade reports. 

 

1. Highlight the Page 1 node on the left side of your screen, if it is not already highlighted. 

2. Select the Page menu, click Insert and then click OCR Region After Selected Page, or click the 

OCR toolbar button to insert an OCR region. Alternatively, select the Define regions link in the 

task pane and then select Insert OCR region. 

The mouse changes to a crosshair. 

3. To create the OCR region, place the cursor just beyond the top left of the text, then press and 

hold the left mouse button while dragging the rectangle beyond the bottom right corner of the 

text, making sure you have selected the entire allotted space. For OCR areas, capture a little extra 

space at the end of the text to accommodate the largest amount of text you might process 

(student names will vary in length). 

 

 

 

 

4. After positioning the box, release the mouse button and the Properties window appears to allow 

you to define the region’s properties. This window allows you to provide pertinent information 

about the text.   

Tip: You can use your cursor to drag/slide the Properties box on your screen if you 
need to see anything on your form. Do not worry if the region is not drawn perfectly at 
this point because you can easily adjust it by dragging the borders as needed after the 
region’s properties are defined and the Properties window closes. 

5. Type Student Name in the Region name box. The Region name provides a brief description of 

the region and becomes the name for this column in your data set.   

6. Set the OCR type to Primary. Primary OCR works well in most cases and is the default setting. 

(Microsoft Office Document Imaging is a second OCR option available if you have Microsoft 

Office 2007 or later installed on your computer. Legacy OCR refers to an older OCR engine that 
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was used in the software previously. Microsoft Vision requires a Microsoft Azure Cloud Vision 

account.) 

7. The following options should be set to their default settings: 

• Data Type is Textual. We are collecting student names, which are textual. If we were to 

export our data once it is collected, the data type would be flagged as textual in the output 

File. When creating your own form templates, the 

data type you select can be textual or numeric, 

depending on the type of data you require.  

• Language is English, Middle. 

• Orientation to Left to Right. The text on our form 

is oriented from left to right 

• OCR Image Pre-Process Options are all 

unchecked. 

8. Mark the checkbox for Region contains more than 

one word. This region contains both a first and last 

name for each student. 

9. Click the Advanced Region Properties link in the Task 

Pane to the left.  

10. Click the Analysis button. 

11. Mark the checkbox for Designate as a respondent ID during analysis. When you run reports in 

Remark Quick Stats, any regions marked as Analysis Respondent IDs appear on select reports to 

identify each respondent. This way you can run student grade reports with the students’ names 

on them to hand back to the students or parents. 

12. Click the OK button. 

13. Click the OK button to return to the main Template Editor window.  

You now see a purple box around the text in the image area, identifying it as an OCR region, and a 

new node in the tree view titled Student Name. 

 

To define the Teacher Name as a Barcode region 

The Teacher Name is defined as a barcode region. Using a barcode allows you to quickly collect each 

teacher’s name and then use this information on subsequent grade reports. In our case, we will filter 

our data by teacher to evaluate teacher performance. 

 

1. Highlight the Student Name node on the left side of your screen if it is not already highlighted. 

2. Select the Region menu, click Insert and then click Barcode Region After Selected Region, or 

click the barcode toolbar button to insert a Barcode region. Alternatively, select the Define 

regions link in the task pane and then select Insert Barcode region. 

The mouse changes to a crosshair. 

3. To create the Barcode region, place the cursor just beyond the top left of the barcode, then press 

and hold the left mouse button while dragging the rectangle beyond the bottom right corner of 

the barcode, making sure you have selected the entire allotted space. For barcodes, capture a 
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little extra space at the end of the barcode to accommodate the largest possible barcode you 

might process. It is okay to encapsulate the text beneath the barcode since it is small. 

 

 

 

 

 

4. After positioning the box, release the mouse button and the Properties - Barcode Region 

window appears, allowing you to define the region’s properties. This window allows you to 

provide pertinent information about the barcode.   

5. Type Teacher Name in the Region name box. The Region name provides a brief description of 

the region and becomes the name for this 

column in your data set.   

6. Set the Barcode type to Code 39 and the 

Barcode orientation to Horizontal. These 

settings allow you to specify the barcode type to 

recognized and/or positioning of the barcode on 

your form. 

7. Set the Data Type to Textual. We are collecting 

teacher names, which are textual. If we were to 

export our data once it is collected, the data type 

would be flagged as textual in the output File. 

8. Click the OK button to return to the main 

Template Editor window.  

You now see an orange box around the barcode in 

the image area, identifying it as a Barcode region, and a new node in the tree view titled Teacher 

Name. 

 

To define the test questions as OMR regions 

The 50 test questions are broken into two sections, each containing 25 questions. You create an OMR 

region for the first 25 questions and then copy and paste that region to the other set of 25 questions. 

Tip: When creating similar regions, using copy and paste can save time. Once you paste 
a region, you can access its properties to make any changes. However, by copying 
similar regions, you save time in entering all of the region information. 

 

1. Highlight the Teacher Name node in the left side of your screen if it is not already highlighted.  
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2. Click the OMR toolbar button  to insert an OMR region, and use the crosshair to draw a box 

around the first set of 25 questions, beginning at the top left with the first “A” bubble 

(question 1) and ending at the bottom right for the last “E” bubble (question 25).  

Tip: When defining an OMR region, include only the actual marks; never include the 
nearby labels, text, etc. Also, create approximately a 1/8 inch buffer space between the 
marks and the edge of the defined region. This buffer allows Remark Office OMR to 
accommodate minor shifting or skewing during form processing and decrease the 
number of data exceptions you need to clean in the resulting data.   

After positioning the box, release the mouse button. The Properties – OMR Region window 

appears, allowing you to enter information that will define the OMR region and the data it 

produces, including:  

• Region Definition (the area containing Region name, the type of OMR region or OMR type 

and the Data type).  

• Region Layout (the area detailing how many Rows and Columns of marks are contained in 

the region and their orientation).  

• Possible Responses (the Labels you want to see as your data). 

3. Enter Question in the Region name box. We call the two regions containing the 50 questions 

“Question.” Your region names then become Question1 through Question50. 

4. Select Multiple as the OMR type. The Multiple region designation is used for typical multiple 

choice style questions.  

Note: There are other types of OMR regions that can be seen if you click the down 
arrow to the right of Multiple. These additional region types offer differing types of 
data output. The additional OMR region types are explained in your Remark Office OMR 
user’s guide. 

5. Select Textual for the Data type. This region contains the answer choices A-E, so textual data is 

appropriate. 

6. In the Region Layout area, select Row for the Region orientation because each question 

occupies one row. 

7. Ensure that 5 was entered in the Columns in the 

region box and 25 in the Rows in the region box. The 

5 columns represent our answer choices (A-E) and the 

25 rows represent our 25 different questions. 

8. Use the Possible label scales drop-down list to select 

A-E. These labels automatically fill the Labels grid. Your 

choice of Labels in the form template determines what 

you see in the data set when your filled in forms are 

processed. The Labels represent the response choices 

for each bubble, moving from top to bottom. Notice 

that each Label automatically has a value in the Values 

column to the right. While the Labels represent the 

data you see returned from the processed forms, the 

Values represent the information Remark Office OMR uses to perform any statistical analysis 

(these values are not grading point assignments).    

9. Click the OK button to return to the main Template Editor window.  
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You now see a green box around questions 1-25 in the image area, identifying them as an OMR 

region, and a new node in the tree view titled Question. 

 

To copy and paste the Question OMR region 

Next, copy the region you just created and paste it over the remaining 25 questions. Copying similar 

questions saves time in the template creation process.  

 

1. With the Question node highlighted in the tree view, select the Edit menu and then click Copy. 

2. Select the Edit menu and then click Paste. 

Tip: You can use the keyboard shortcut keys for Copy (Ctrl + C) and Paste (Ctrl + V) 
for quick copying and pasting. 

A red region is drawn near questions 1-25.  

3. Place the mouse directly over the red region 

until it becomes two double arrows and then 

drag the new region to questions 26-50, 

positioning it directly over the 25 questions.  

4. Release the mouse. Check your positioning; 

if the solid red color disappears, this is an 

indication that you have moved the box 

successfully. If the region is still red, hover 

your mouse over it to see text describing 

where the problem lies. 

You should now have two OMR regions, one covering each of the groups of 25 questions, and two 

nodes in the tree view titled Question (1-25), Question (26-50). 

 

To create the bonus question OMR region 

The question at the bottom of the exam answer sheet that reads Bonus is used to add extra credit 

points to the overall test score.  

 

1. Highlight the Question (26-50) node in the tree view, if it 

is not already highlighted.  

2. Click the OMR toolbar button to insert an OMR region, 

and use the crosshair to draw a box around the bonus 

question’s bubbles (A-E).  

3. When the Properties – OMR Region box opens, enter 

Bonus in the Region name box.  

4. Select Multiple as the OMR type. This is a multiple-

choice question.  

5. Select Textual for the Data type. This region contains 

the answer choices A-E, so textual data is appropriate. 
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6. In the Region Layout area, select Row for the Region orientation because the question is 

oriented in one row. 

7. Enter 5 in the Columns in the region box and 1 in the Rows in the region box. The 5 columns 

represent our answer choices (A-E) and the 1 row represents our single bonus questions. 

8. Use the Possible label scales drop-down list to select A-E. These labels automatically fill the 

Labels grid. The Labels represent the data output you see when you process forms. 

Corresponding values are automatically entered in the Values grid. These Values are used for 

statistical analysis (these values are not grading point assignments). 

9. Click the Analysis button.  

10. In the area called Testing Point System, mark 

the checkbox for Treat points as extra credit. 

When grading, whether using Quick Grade or 

Advanced Grade, this question is considered 

extra credit. 

11. Change the number set for Correct points to 5. 

When the tests are graded, if the student gets 

the bonus question right, they will be rewarded 

5 extra credit points. 

12. Click the OK button. 

13. Click the OK button to return to the main Template Editor window.  

You now see a green box around the Bonus question in the image area, identifying it as an OMR 

region, and a new node in the tree view titled Bonus. 

 

To create the Official Use Only OMR region 

The Official Use Only area allows a teacher to bubble in points awarded for a subjective question on 

the test. Subjective questions could be essays, short answer questions, etc. This type of question has 

to be graded by a person, but you can add the points earned to the total test score by designating it 

as a subjective question. 

 

1. Highlight the Bonus node in the tree view, if it is not already highlighted.  

2. Click the OMR toolbar button to insert an OMR region, and use the crosshair to draw a box 

around the entire set of bubbles in the Official Use Only area question’s bubbles (0-9).  

3. When the Properties – OMR Region box opens, enter Subjective in the Region name box. We 

title it Subjective in order to remember that this question is for designating our subjective points 

for the human-graded part of the test. 

4. Select Grid as the OMR type. Grid regions capture information that spans across multiple rows 

and columns, but consists of a single piece of data (e.g. zip codes, names, social security numbers, 

phone numbers, etc.). In our case, the teacher bubbles in a two-digit number representing the 

points earned on the subjective portion of the test.  
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5. Select Numeric for the Data type. This region contains 

a two-digit number, so numeric data is appropriate. 

6. In the Region Layout area, select Row for the Region 

orientation because the question is oriented by row 

(each row is one digit in the two-digit number). 

7. Enter 10 in the Columns in the region box and 2 in the 

Rows in the region box. The 10 columns represent our 

answer choices (0-9) and the 2 rows represent the digits 

in the subjective score. 

8. Use the Possible label scales drop-down list to select 

0-9. These labels automatically fill the Labels grid. The 

Labels represent the data output you see when you 

process forms.  

9. Click the Analysis button.  

10. Under Test Settings, mark the option for Grade this 

item. Grid regions are not set to grade by default like 

multiple choice regions. 

11. In the Testing Point System area, under Item test 

type, select Subjective. For Subjective points, enter 

20. The question is worth 20 points total. The teacher 

will bubble in the points earned for each student. 

12. Click the OK button. 

13. Click the OK button to return to the main Template Editor window.  

You see a green box around the Official Use Only question in the image area, identifying it as an 

OMR region, and a new node in the tree view titled Subjective. 

 

To save the Tutorial 1 form template 

We are finished creating all of the regions in our form template and need to save the form template 

as a File we can use to process completed forms. 

 

1. Select the File menu and then click Save. Alternatively, select the Save link in the Task Pane. Make 

note of where you save the form template File (we suggest in \Documents\Remark Office 

OMR\Tutorials\Tutorial 1, but not overwriting the tutorial File that we supply in case you need it 

later). 

2. In the File name box, type Tutorial1 and then click the Save button.  

You have now created the Tutorial 1 form template. Close the Template Editor by selecting the File 

menu and then clicking Exit. Alternatively, you may also simply click the X in the upper right hand 

corner of the Template Editor window. 
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Processing the Completed Answer Sheets 

Now that you have created the form template for the Test Answer Sheet you are ready to begin 

processing the completed forms using the supplied image Files.   

 

To open the Test Answer Sheet form template 

1. If not already running, start the Remark Office OMR Data Center (Start|Programs|Remark Office 

OMR|Remark Office OMR Data Center). When the Data Center opens, it displays a blank 

spreadsheet-style data grid.  

3. Select the File menu and then click Open Form Template. Alternatively, select the Open Other 

Templates link in the Task Pane. You must open a form template in order to process forms. 

Tip: When you are in the Remark Office OMR Template Editor with a form template 
open, you can select File|Launch Remark Office OMR and the Data Center opens with 
the selected form template also open. 

4. Select the Tutorial1.omr File you created in the previous section of this tutorial and then click the 

Open button. Alternatively, we have provided a sample File in \Documents\Remark Office 

OMR\Tutorials\Tutorial 1\Remark Office OMR Tutorial 1 – Sample Test.omr. 

When the Tutorial1 form template opens, its name appears on the title bar at the top of the screen 

and you see the region names you specified as your column headers in the data grid. Each column in 

the grid corresponds with one variable or question in the form template, as the column headers 

indicate. The data grid fills row by row as your completed forms are processed. Each grid row contains 

information from one processed form regardless of the number of Pages the form contains. 

 

To read from image Files 

The Read window is used to process completed forms and produce data. The Read window has 

several steps to help customize the reading process. This tutorial focuses on the basic functions. As 

stated previously, we are reading pre-scanned image Files. 

 

1. Select the Tools menu and then click Read. 

Alternatively, you may select the Read link from the 

task pane or Read button on the toolbar. 

2. Select the Read Images button if it is not already 

selected. 

3. Click the Next button to continue. 

The Image Selection window appears to enable you to 

view and select the images you want to process. 

4. Navigate to the Tutorial 1 folder of your Remark 

Office OMR installation (e.g. \Documents\Remark 

Office OMR\Tutorials\Tutorial 1). 
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5. Navigate to the Images for Processing folder.  

6. Select the Files called Tutorial 1 – Answer Key.tif 

and Tutorial 1 – Completed Test Forms.tif by 

either double clicking them or selecting them and 

clicking the Add Selected, which moves them into 

the Images in Read Order window on the right. You 

may also click Add All button to move any images in 

the folder to the Images List (in Read Order) 

window. Note that the first File in the list is the 

answer key for the test. The second File is a multi-

Page TIF image File that contains 20 student tests. 

You must select the answer key first. 

Tip: You can use the Ctrl or Shift keys to select 
multiple image Files and then use the Add 
Selected Images button to move the images to 
the Images in Read Order window. 

7. Click the Next button to continue. 

The Review Exceptions window appears. This window allows you to configure options for reviewing 

exception cases such as blank and multiple responses. We will not be using this feature in this tutorial.  

8. If the Enable Review Exceptions button is selected, click it to deselect this option. We are not 

reviewing exceptions at this time. 

9. Click the Read button to begin reading the image Files. 

As each image is processed, you see a row added to the data grid.  

Reviewing and Correcting the Data 

After the forms are processed, 21 rows of data are displayed in the data grid. Each row represents the 

responses collected from one of the forms. The first row is the answer key for the test, and the 

following rows are student tests. You are now ready to inspect the data for missing or unrecognized 

responses in order to prepare for analysis and/or data export.   

 

How does the software handle data exceptions? 

Remark Office OMR informs you of unrecognized or questionable responses by placing a visible 

marker in each appropriate data grid cell. Each one of the types of problematic or potentially 

inaccurate data is represented by a specific color and explanatory text (e.g. yellow color and the word 

BLANK).  

The software then assists you to correct exception cases or problems by allowing you to see what was 

entered on the actual form. The stored images for each processed form are available to display your 

respondents’ answer choices. You can click inside any cell in the data grid to view the corresponding 

image of that form. (If you click in a cell and do not see an image beneath the data grid, select the 

View menu and then click Image Viewer to open the Image Viewer.) 

 

 



15 

 

To run Review Exceptions 

We use an automated tool called Review Exceptions to locate and correct any exceptions in our data. 

1. Click the Tools menu and then select Review Exceptions, or click the Review Exceptions link in 

the Task Pane. 

2. Once you access Review Exceptions, use the task pane to select the exception cases you would 

like to review: Blank responses, Multiple Responses, Recognition Errors, Image Regions, Database 

Lookup Regions, Barcode Regions, OCR Regions, Repeated Rank Responses or Required Items. 

You can also choose whether to search by rows or columns in the data grid. 

3. Click the NEXT button at the top of the data grid to start the review process. 

The Data Center searches the data for the specified exception cases. When a selected exception case 

is found, it appears in the data header bar at the top of the data grid. The bar is color coded to match 

the exception type (e.g. yellow for a BLANK response). Use this window to make changes. You can use 

the drop-down list if applicable, or type a response. Note if there is a list of answer choices defined, as 

you begin typing, Remark Office OMR will attempt to auto-fill your answer based on your possible 

answer choices.  

3. The first piece of flagged data is a 

multiple response in the eighth grid row 

for the item called Question8. In the data 

header bar use the drop-down list to 

select the appropriate response. Use the 

Image Viewer beneath the data grid to 

review the student’s exam. In this case, 

you see the student accidentally marked A 

and then put an X through it. The 

intended response was B. Select B from 

the drop-down list. You may also simply 

type B. 

4. Press Enter or click the NEXT button to continue. 

5. The next exception is a multiple response in row 16 for question 12. Look at the Image Viewer to 

see the intended response. In this case, the student marked both D and E, but crossed out E. Use 

the drop-down list in the Review Exceptions pane to select D from the list (or type D). 

6. Press Enter or click the NEXT button to continue. 

7. The next exception is a blank response in row 17 for question 6. Look at the Image Viewer to see 

the intended responses. In this case, the student truly left the question blank. You may simply 

press Enter to ignore it. The question will be marked as incorrect when the data are scored. 

8. Press Enter or click the NEXT button to continue. 

9. All exceptions have been cleaned and you are prompted to save the changes. Click the Save 

Changes button to save your changes.  

Your data set is now ready to be saved and analyzed. 
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Saving the Test Data 

Remark Office OMR provides many File formats for exporting data to other applications. For this 

tutorial, the data set is saved to the Remark Extended (RMX) format, which is a proprietary format 

within the software. This format saves the exception colors (if any are present) as well as the link from 

the data to the stored images so that you can open your data and still view the image that 

corresponds with any piece of data. 

 

To save the exam data 

1. Select the File menu and then click Save Data, or click Save Data in the Task Pane. 

2. Data can be saved anywhere on your system. By default, a Data folder is installed in the Remark 

Office OMR directory; we recommend using this folder for storage of data Files. In the Look in 

box, navigate to this Data folder on your system (e.g. \Documents\Remark Office OMR\Data). 

3. Click the Save as type down arrow to display a list of File types.  

4. If not already selected, click the Remark Extended (.RMX) format.  

5. Type Tutorial1 in the box titled File name. 

6. Click the OK button to save the File. 

Grading the Test Data 

Remark Office OMR provides statistical analysis functionality for grading data from your tests. There 

are two ways to grade an exam: 

Quick Grade: Uses the first grid row as the answer key by default as well as all settings defined in the 

form template (e.g. whether a question is graded, assigned point values and respondent identifiers). 

Advanced Grade: Allows you to customize the grading process, including adding benchmark values, 

customized grade scales and learning objectives (subtests). 

For this tutorial, we will demonstrate Advanced Grade.  

Tip: The Remark Quick Stats module of the software includes various ways to 
tabulate/grade data and display reports. Review the Remark Quick Stats User’s Guide 
PDF File by clicking Start|Programs|Remark Office OMR|Documentation to see all 
available analysis features. 

 

To grade the exam data 

1. Select the Tools menu, click Analysis and then click Advanced Grade, or select the Analysis tab 

in the Task Pane and then click the Advanced Grade link. 

The Basic Test Options window appears. 
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2. Mark the checkbox for Use a test benchmark, 

choose Custom and enter the number 75. A 

Benchmark is a target score you want your 

students to achieve. Reports that include 

benchmarks show you which students 

achieved the benchmark percent, which did 

not and the difference between the student’s 

score and the benchmark. Using Benchmarks 

is useful for seeing how well your students are 

mastering topics. 

3. Click the Answer Key link in the Task Pane to 

continue. 

The Answer Key window appears. This window is 

where you specify an answer key. You may scan a 

key, import a key from an image File, use a grid 

row as the key or type an answer key. In our case, 

we processed the answer key as the first row of 

our data grid.  

4. In the Import answer key from box, use the 

drop-down arrow to select Data Set (Grid) 

Row. By default, the grid row box is filled with 

the number 1.  

5. Click the Import Key button to obtain the 

answer key responses from the data grid. 

6. Click the Question Properties link in the Task 

Pane to continue. 

The Question Properties window appears. This window allows you to change properties you defined 

in the form template for this grading session. You may change things such as respondent identifiers, 

point values, correct answers, data type and question text. You may also add a benchmark value for 

individual questions. Changes made here do not change the form template. You may hold down the 

Shift or Ctrl keys and select multiple questions to make the same change to each question. For the 

purposes of this tutorial, we set up everything correctly in the form template, so we do not need to 

make any adjustments to this window. 

7. Click the Learning Objectives link in the Task Pane to continue. 

The Learning Objectives window appears. This window is where you define learning objectives 

(sometimes called subtests). You may assign questions to each learning objective you define so that 

the software provides a separate grade for that subset of questions. This feature allows you to track 

progress on specific objectives that you are teaching your students. For this tutorial, we are defining 

two learning objectives. 

8. Click the New button. 

9. In the Objective name, enter Spelling. 

10. Mark the Use benchmark box, select Custom and enter 75. Using a benchmark score indicates 

that your students need to score at least 75% on this learning to be considered proficient at 

spelling. 
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11. Click the New button. 

12. Enter Grammar in the Objective name box. The same benchmark value of 75 is prefilled for you.  

You should now have two learning objectives defined: Spelling and Grammar. The next step is to 

pick the questions that belong to each Learning 

Objective. 

13. Highlight Spelling in the Learning 

objectives column.  

14. In the Available questions column, click 

Question1. Hold down the Shift key and 

then click Question10. Question1 through 

Question10 are selected. 

15. Click the Align Questions button. The 

questions appear under Spelling in the 

Learning objectives column. 

16. Highlight Grammar in the Learning 

objectives column. 

17. In the Available questions column, click Question11, hold down Shift and then click 

Question20. Question11 through Question20 are selected. 

18. Click the Align Questions button. The questions appear under Grammar in the Learning 

objectives column. 

19. We are finished setting up the answer key, so click the Grade button.  

You are prompted to save the answer key. Saving answer keys is useful if you administer the same test 

on multiple occasions.  

20. Click the Yes button to save the answer key. 

21. In the Save Answer Key window, type Tutorial1 in the File name box. 

22. Click the Save button to save the File. You receive a confirmation notice that the File was saved 

and then Remark Quick Stats opens. 
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Reviewing Grade Results and Reports 

Once Remark Quick Stats opens, you have access to a variety of grade reports. You can report on the 

test itself, the class or individual students. For this tutorial, we will look at the Student Statistics, 

Student Response and Student Grade Reports. 

 

To run the Student Statistics Report 

1. By default, the Student Statistics report displays automatically. If you are not seeing this report, 

select the Student Statistics link in the list of reports under Class and Student Reports.  

The Student Statistics Report displays the 

grades for the entire class. Each student can 

optionally be identified by an Analysis 

Respondent ID region (chosen in the form 

template or Advanced Grade) if desired. In 

this tutorial, we designated the Student ID 

barcode as an Analysis Respondent ID. You 

can also view the benchmark information 

and learning objectives. This report 

provides a nice overview of how your class 

is performing. Use the Page Navigation 

Tools at the top of the window to review 

the various Pages of your report. 

2. To gain some comfort with the Remark Quick Stats window, go to the toolbar and use the Full 

Screen button to expand the report. Then toggle back to the default view by selecting the button 

again. If you need to, use the Zoom In and Zoom Out buttons to increase or decrease the size of 

the report image. 

Next, we will look at the Student Response Report. 

 

To run the Student Response Report 

The Student Response Report allows you to 

view class and question performance, along 

with score data in a graphical format. 

 

1. In the Task Pane under Class and 

Student Reports, select the Student 

Response link.  

The report displays each question across 

the top and each student down the left. 

Green indicates the question was answered 

correctly, red indicates the question was answered incorrectly and white indicates the question was 

left blank. Means are included at the bottom of each column. Use the Navigation Tools at the top of 
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the window to scroll to the second Page, where you find summary score information. Report colors 

are customizable in the report’s options, located in the Style Pane on the right side of the window.  

Finally, we will look at the Student Grade Report. 

 

To run the Student Grade Report 

1. In the Task Pane under Class and Student Reports, select 

the Student Grade link.  

2. Select one or more students from the Respondents list and 

click the Add button to move them to the Selected 

respondents list. Alternatively, click the Add All button to 

move all students over. 

3. Click the Run Report button; the report displays on the right. 

The Student Grade Report shows an individual report of each 

student’s grades. You can show the correct and incorrect 

responses, as well as an image of the actual test as it was 

scanned. You can also add customized headings such as high, low 

and mean scores for the class. Learning objectives are tracked, as 

well as subjective and extra credit points.  

Exporting the Student Grade Reports 

Once you have tabulated your data, you can save a report and/or export the report to one or more 

formats for either storing or sharing with others. For this tutorial, we will export the Student Grade 

Reports to PDF Files. Saving to this format allows you to email test grades to parents, for example. 

 

To export the Student Grade Reports  

1. Select the File menu, click Export and then 

click Report, or click the Export Report link in 

the Task Pane. 

2. In the Export Report box, select Portable 

Document Format (PDF).  

3. In the Pages area, select All.  

4. Set the Image quality to its default value of 

High. 

5. Click the Export button to choose a location 

and File name for the PDF File. 

6. In the Save As window, use the Look in drop-

down list to locate a folder on your computer 

for the File. For this tutorial, use My 

Documents or another folder where you can easily access the exported report. 

7. Click the Save button to export the report. 
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You may now go to the My Documents folder on your computer and view the resulting PDF Files. 

You have completed the first tutorial. Look below for a summary, and then continue on to Tutorial 2 

for more practice. 

Tutorial 1 Summary  

The first tutorial illustrated basic and some advanced features of the software, including: 

• Creating a form template 

o Setting advanced region options 

• Processing forms 

• Using Review Exceptions to clean data 

• Saving data 

• Grading tests with Advanced Grade  

• Exporting reports 
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Tutorial II – The Hospital Stay Survey  

The second tutorial quickly teaches you how to use the basic software functions and how to easily 

navigate the software’s user interface. You will create a form template for a hospital stay evaluation. 

This evaluation is a typical survey form containing several types of areas that Remark Office OMR 

recognizes, including text, OMR bubbles and an area for gathering comments. The survey asks 

previous hospital patients to provide details about when and where they stayed and then answer 

some basic questions to evaluate their stay. A survey such as this one can be scanned to produce data 

and subsequently, reports to show how the hospital is performing. 

You will perform the following steps in this tutorial: 

• Create the Hospital Stay Evaluation form template 

• Process completed Hospital Stay Evaluation forms 

• Review and correct the data output 

• Save the Hospital Stay Evaluation data 

• Analyze the Hospital Stay Evaluation data with Remark Quick Stats 

Creating the Hospital Stay Evaluation Form Template 

The first step in this process is to create a form template outlining the areas on the form that you 

want the software to recognize. 

 

1. If not already running, start Remark Office OMR (Start|Programs|Remark Office OMR|Remark 

Office OMR Data Center). 

2. Begin a new form template. Select the File menu and then click New Form Template. 

Alternatively, in the left-hand panel, known as the Task Pane, select New under the Templates 

tab. Any of these actions will open a second window containing the Remark Office OMR 

Template Editor.  

Tip: If you use File|New Form Template or the New link in the Task Pane, the 
Template Editor opens with the new form template window already opened for you.  

3.  [Optional] If the Template Editor opens but you do not see the Properties - Form Template 

(New) window, select the File menu and 

then click New Form Template. 

The Properties - Form Template (New) window 

opens. This window is where you describe your 

form to Remark Office OMR. You do this by 

entering basic information about your form, 

including the form template description, Page 

size and Page orientation.  

4. Enter Hospital Stay Evaluation in the 

Description box.  
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5. Locate the Page size area where you can tell the software the size paper your form uses. If not 

already listed, select US Letter in the Size drop-down list.  

6. Locate the Orientation area and select Portrait. 

7. Click the Capture Image button to continue.  

The Create Page Elements window appears. The Create Page Elements window allows you to either 

acquire an image of your form from your scanner, or acquire an image of your form from an existing 

image File. Each Page in a form template is created using an image of the appropriate Page in your 

form. The image allows you to see the form so that you can easily teach Remark Office OMR how to 

read it.  

 

To obtain a form template image 

As previously mentioned, there are two ways to acquire an image for a form template Page. Images 

can be acquired by scanning to create a new image File or by opening an existing image File. We will 

be acquiring our image from a pre-scanned image File stored on your computer. 

 

1. Click the Read Images button in the 

Image Collection Method area. 

2. Click the Browse button. The Select 

Image File window opens.  

3. Select the Tutorial 2 – Hospital Stay 

Survey.tif File from the Tutorial 2 folder 

of your Remark Office OMR installation 

directory (e.g. \Documents\Remark 

Office OMR\Tutorials\Tutorial 2) and 

then click the Open button. 

Once an image is acquired by opening an 

existing image File, the Template Editor displays a thumbnail of the image for your approval. 

4. When a thumbnail image of your form appears, click the OK button to accept the image.  

Once the thumbnail image is accepted, the Template Editor opens the new form template where you 

can begin to define the regions. You see a tree view (item list) on the left and an image representation 

of your form on the right.   

 

To define form template regions   

The purpose behind making a form template is to tell the software where to locate the information on 

your specific form and how to understand your specific data requirements. The following table lists 

the six regions on the Hospital Stay Evaluation form and their corresponding region types: 
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Area on Form Corresponding Region Type 

Hospital Name OCR 

Hospital Unit OMR (Multiple) 

Length of Stay OMR (Multiple) 

Room Number OMR (Grid) 

Evaluation Questions OMR (Multiple) 

Comments Image 

 

To define the hospital name as an OCR region 

The hospital name text is located in the upper left hand corner of the form and is defined as an OCR 

region. Remark Office OMR reads the pre-printed text automatically so that the responses can be tied 

back to specific hospitals.   

 

1. Highlight the Page 1 node on the left side of your screen, if it is not already highlighted. 

2. Select the Page menu, click Insert and then click OCR Region After Selected Page, or click the 

OCR toolbar button. Alternatively, select the Draw regions link in the Task Pane and then select 

Insert OCR region. 

The mouse changes to a crosshair. 

3. To create the OCR region, place the cursor just beyond the top left of the text, then press and 

hold the left mouse button while dragging the rectangle beyond the bottom right corner of the 

text, making sure you have selected the entire allotted space. Because text length may vary 

depending on the name of each hospital, capture a little extra space at the end of the text to 

accommodate the largest possible hospital name you might process. 

 

 

 

 

 

4. After positioning the box, release the mouse button and the Properties window appears, 

allowing you to define the region’s properties. This window allows you to provide pertinent 

information about the OCR region.   

5. Type Hospital in the Region name box. The Region name provides a brief description of the 

region and will become the name for this column in your data set.   

6. Set the OCR type to Primary. Primary OCR works well in most cases and is the default setting. 

(Microsoft Office Document Imaging is a second OCR option available if you have Microsoft 

Office 2007 installed on your computer. Legacy OCR refers to an older OCR engine we had in 

previous software versions. Microsoft Vision requires a Microsoft Azure Cloud Vision account.)  

7. The following options should be set to their default settings: 
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• Data Type is Textual. We are collecting 

hospital names, which are textual. If we were to 

export our data once it is collected, the data 

type would be flagged as textual in the output 

File. 

• Language is English, Middle. 

• Orientation to Left to Right. The text on our 

form is oriented from left to right 

• OCR Image Pre-Process Options are all 

unchecked.  

8. Mark the checkbox for Region contains more 

than one word. Each hospital name contains more 

than one word. 

9. Click the OK button to return to the main Template Editor window.  

You now see a purple box around the text in the image area, identifying it as an OCR region, and a 

new node in the tree view titled Hospital. 

 

To define the Hospital Unit as an OMR region 

The Hospital Unit question contains two columns of bubbles separated by text. Therefore, we have to 

use the software’s Append Linked Region feature to link the second set of bubbles to the first set of 

bubbles. When linking regions that have text in the middle of them, you create a region around the 

first set of bubbles, then link the second set to the first set. (You cannot create one OMR region 

around bubbles that have text between them.) 

 

1. Highlight the Hospital node by clicking it in the tree view, if it is not already highlighted.   

2. Select the Region menu, click Insert and then click OMR Region After Selected Region, or click 

the OMR toolbar button. Alternatively, select the Insert OMR Region link in the Task Pane. 

The mouse changes to a crosshair. 

Tip: When defining an OMR region, include only the actual marks; never include the 
nearby labels, text, etc. Also, create approximately a 1/8 inch buffer space between the 
marks and the edge of the defined region. This buffer allows Remark Office OMR to 
accommodate minor shifting or skewing during form processing and decrease the 
number of data exceptions you need to clean in the resulting data.   

3. Place the cursor just to the left of the top bubble for “Cardiac”, then press and hold the left mouse 

button while dragging the rectangle to the bottom right corner of the region, the bubble for 

“Maternity”, capturing all three bubbles in the region. 

After positioning the box, release the mouse button. The Properties - OMR Region window appears. 

The Properties - OMR Region window allows you to enter information that will define the OMR region 

and the data it produces, including:  

• Region Definition (the area containing Region name, the type of OMR region or OMR type 

and the Data type).  
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• Region Layout of the region (the area detailing 

how many Rows and Columns of marks are 

contained in the region and their orientation).  

• Possible Responses (the Labels you want to see 

as your data). 

4. In the Region Definition area, enter Hospital Unit in 

the box titled Region name. 

5. For the OMR Type, select Multiple. The Multiple 

region designation is used for typical multiple choice 

style questions.  

6. For the Data type, select Textual. This region 

contains Hospital Unit names, so textual data is 

appropriate.  

7. In the Region Layout area to the right, select Column for Region orientation. Region 

orientation lets Remark Office OMR know how the region is structured on the form. For this 

question, the question’s first set of answer choices is listed in one column. 

8. Ensure that 1 was entered in the Columns in the region box and 3 in the Rows in the region 

box. The region size lets Remark Office OMR know how many rows and columns of marks are in 

the region. 

9. Locate the Labels area, and then type in the text for each unit: Cardiac, General Surgery, 

Maternity, one per line. Your choice of Labels in the form template determines what you see in 

the data set when your filled in forms are processed. The Labels represent the response choices 

for each bubble, moving from top to bottom. Notice that as you type the Labels, numbers 

automatically fill the Values column to the right. While the Labels represent the data you will see 

returned from the processed forms, the Values represent the information Remark Quick Stats uses 

to perform any statistical analysis.    

Tip: When entering Labels into Possible Reponses, you may use the Enter Key to 
move to the next row. 

10. Click the OK button to return to the main Template Editor window.   

You see a green box around the first column of bubbles in the Hospital Unit area of the form, 

identifying it as an OMR region. You also see that Hospital Unit is added to the tree view on the left 

side of the Template Editor. 

 

To append the second set of Hospital Unit bubbles to the first set 

We can now add the second set of options (bubbles) in the Hospital Unit question to the first, using 

the Append Linked Region feature. 

 

1. With the Hospital Unit node highlighted in the tree view, select the Region menu and then click 

Append Linked Region, or click the toolbar button. 

2. Place the cursor just to the left of the top bubble for “Neurology”, then press and hold the left 

mouse button while dragging the rectangle to the bottom right corner of the region, the bubble 

for “Pediatrics”, capturing all three bubbles in the region. 
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3. After positioning the box, release the mouse button. 

The Properties - OMR Region window appears. You 

will notice that everything is filled in for you based on 

the previous OMR region, with the exception of the 

Labels.  

4. Locate the Labels area, and then type in the text for 

each unit: Neurology, Pathology, Pediatrics, one per 

line. Your choice of Labels in the form template 

determines what you will see in the data set when your 

filled in forms are processed. 

5. Click the OK button to return to the main Template 

Editor window.   

You see a green box around the second column of 

bubbles in the Hospital Unit area of the form, identifying it as an OMR region. You also see that the 

two linked regions are outlined with a dashed line to show their linked status. 

 

To define Length of Stay as an OMR region 

The Length of Stay in Days region is a third OMR region designed to output the number of days the 

respondent stayed in the hospital. The steps involved in creating this OMR region are similar to those 

performed for the Hospital Unit. However, notice that many of the region’s properties change to 

reflect that the area on the form has a single row with five columns instead of two columns with three 

rows.   

 

1. Highlight Hospital Unit by clicking its node in the tree view, if it is not already highlighted.  

2. Select the Region menu, click Insert and then click OMR Region After Selected Region, or click 

the OMR toolbar button. Alternatively, select the Insert OMR region link in the Task Pane. 

The cursor changes to a crosshair.   

3. Place the cursor just to the top left of the row of marks representing the Length of Stay, then 

press and hold the left mouse button while dragging 

the rectangle to the bottom right corner capturing all 

of the bubbles in the region. 

4. In the Region Definition area, enter Length of Stay 

in the box titled Region name. 

5. For the OMR type, select Multiple.   

6. For the Data type, select Textual. This region 

contains numbers of days but because one of the 

choices (5+) is not numeric, textual is the correct data 

type.  

7. In the Region Layout area to the right, select Row 

for Region orientation. Region orientation lets 

Remark Office OMR know how the region is 

structured on the form. For this question, the 

question’s answer choices are listed in a row. 
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8. The following should be filled in for you: Columns in the region: 5 and Rows in the region: 1. (If 

not, please enter these values.) 

9. For the Labels area, type the number for each length of stay on each of the rows: 1, 2, 3, 4, 5+, 

one per line. This label range represents the response choices for each bubble, moving from left 

to right. Again notice that as you type the Labels, numbers automatically fill the Values column in 

the grid. 

10. Click the OK button to return to the main Template Editor window.   

You now see a green box around the Length of Stay region in the form area, identifying it as an OMR 

region. You also see that Length of Stay is added to the tree view.  

 

To define Room Number as an OMR region 

The Room Number region needs to capture all five digits as one piece of information. We use a Grid 

OMR region to define the bubbles on the form. A Grid OMR region outputs a single piece of data 

regardless of the number of rows and columns included in the region. This type of region is used for 

items such as dates, ID numbers, social security numbers, etc.  

The steps involved to create a Grid region are the same as you used to create the OMR regions we 

already created. However, the specific properties of the region change to reflect the way the region is 

formatted on the form and the way we want the software to report the data.  

 

1. Highlight the Length of Stay node in the tree view, if not already 

highlighted. 

2. Click the OMR toolbar button to insert an OMR region, and then draw the 

OMR region box around the entire group of bubbles.  

3. After positioning the box, release the mouse button, and the Properties - 

OMR Region window appears. 

4. In Region Definition area, enter Room Number in the Region name box.  

6. Select Grid for the OMR type. 

7. Select Numeric for the Data type. We are capturing a five-digit number. 

8. In Region Layout area, select Column for the Region orientation. Each 

column in this region represents one digit of the room number. 

9. In the Columns in region box, ensure that 5 was 

entered and in the Rows in region box, ensure that 

10 was entered.  

10. Enter the appropriate Labels in Possible Responses. 

For the Labels area, click the down arrow for Possible 

label scales and choose the scale 0 to 9 from the list 

of choices. This range represents the response choices 

for bubbles in all five columns, moving from top to 

bottom. The numbers fill the Labels grid 

automatically. The Labels represent the data that is 

returned from the processed forms when filled in by 

the respondent, and the Grid region returns all 

selections to make a five-digit number. 
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11. Click the OK button to return to the main Template Editor window. 

You see a green box around the Room Number region in the form area, identifying it as an OMR 

region. You also see that Room Number is added to the tree view. 

 

To define the Hospital Stay Evaluation questions as an OMR region 

There are five questions on the form that ask the patient to evaluate his or her hospital stay. All five 

questions share the same evaluation scale of Strongly Agree to Strongly Disagree, which allows them 

to share one set of labels on the form. This compact and logical question area can be captured with a 

single OMR region even though it contains five separate questions. Defining similar questions in one 

region saves time and effort, and is preferable. 

1. Highlight the Room Number node in the tree view, if not already highlighted.  

2. Click the OMR toolbar button to insert an OMR region, and use the crosshair to draw a box 

around the entire group of 20 bubbles (all four columns 

and five rows). This region contains five individual 

questions and each question has four possible answer 

choices.   

3. When the Properties – OMR Region box opens, enter 

Evaluation in the Region name box.  

4. Select Multiple as the OMR type.  

5. Select Textual for the Data type. This region contains a 

scale from Strongly Agree to Strongly Disagree, so 

textual data is appropriate. 

6. In the Region Layout area, select Row for the Region 

orientation because each individual question occupies 

one row of the region. 

7. Ensure that 4 was entered in the Columns in the region box and 5 in the Rows in the region 

box.  

8. In the Possible label scales drop-down list, select the Strongly Agree to Strongly Disagree (4) 

scale. The Labels and Values grids are filled 

automatically with the appropriate labels and values. 

12. In the left Task Pane, select Question Properties. The 

next step is to enter the Question Text and Question 

Names for each of the five questions. 

Tip: Question Text appears on the reports 
generated in Remark Quick Stats and is useful when 
exporting to some data formats. Question Names 
can be used to enter individual names for every 
question within one OMR region. If the Question 
Names grid is left blank, the software uses the 
Region Name defined on the previous screen and 
appends sequential numbers to the end of the name 
to differentiate the questions. Individual Question 
Names are useful if you are exporting data to an 
existing File that requires specific field names (e.g. an Access table). 
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13. Enter the Question Text and Question Names for each of the five questions as shown here:  

Question Text:       Question Names: 

 

The staff was responsive to my needs.    Responsive 

The staff treated me with respect.     Respect 

Medical procedures were explained in terms I understood.  Explanations 

My doctor was available to answer questions.   Questions 

My overall rating of this hospital is favorable.            Overall 

 

14. Click the OK button to return to the main Template Editor window.  

You see a green box around the Hospital Stay Evaluation region in the form area, identifying it as an 

OMR region. You also see that Evaluation is added to the tree view. 

 

To define the Comment area as an Image region 

Areas in which you expect your respondent to use handwriting can be captured by Remark Office 

OMR as Image regions. Image regions offer you three different ways to capture handwriting: 1) the 

software takes a snapshot of the handwriting and stores it on your computer as an image File, 2) the 

software allows you to hand enter the written information into your data set using image assisted 

data entry, 3) you apply qualitative codes that characterize the comments as you read them on-

screen. For image clips and data entry regions, you can run a Respondent Report in Remark Quick 

Stats to view the information from the Image region. For qualitative codes, you can run an Item 

Analysis report. We are capturing a snapshot of the handwriting (image clip). 

 

1. Highlight the Evaluation node in the tree view, if not already highlighted, and then click the 

Image toolbar button to insert an Image region.    

2. Once the cursor becomes a crosshair, place the cursor at the top left of the area where you would 

expect the respondent to enter their comments. Press and hold the left mouse button while 

dragging the rectangle to the bottom right corner of the area, making sure you have selected the 

entire allotted space.  

   

     Comments: 

 

 

 

3. After positioning the box, release the mouse button and the Properties – Image Region window 

appears, allowing you to define the region’s properties.  

4. Enter Comments in the Region name box. 

5. Set the Region type to Image clip. This type captures each respondent’s response as a small 

image File for storage on your computer. You can then run a report in Remark Quick Stats to 

review the comments. 
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6. At the bottom of the Region Definition area, mark the setting for Attempt to detect the 

presence of handwriting in the region. By using this feature, Remark Office OMR searches for 

handwriting in the Image region area during 

form processing. If writing is found, the image 

clip is captured, and the path to the clipped 

image File is displayed in the data grid. 

7. In the Target folder box, click the ellipsis to 

choose the Images folder of your Remark 

Office OMR installation (e.g. My 

Documents\Remark Office OMR\Images). 

Whenever a comment is found, a small image 

File is captured and stored in this folder. 

8. In the Begin names with box, type Tutorial 

Comments. When the images are captured, the 

image names begin with the text “Tutorial 

Comments” so that you know they belong to 

this form. 

9. Set the Clip File type and Compression to the default settings of TIF and Group 4. 

10. Click the OK button to return to the main Template Editor window.  

You see the new Image region visible as a blue field on your form and that Comments is added to 

the tree view of your form template.  

 

To save the Tutorial 2 form template 

We are finished creating all of the regions in our form template and need to save the form template 

as a File we can use to process completed forms. 

 

1. Select the File menu and then click Save or select the Save link in the Task Pane. Make note of 

where you save the form template File (we suggest \My Documents\Remark Office 

OMR\Tutorials\Tutorial 2). 

2. In the File name box, type Tutorial2 and then click the Save button. 

You have now created the Tutorial 2 form template. Close the Template Editor by selecting the File 

menu and then clicking Exit. Alternatively, you may also simply click the X in the upper right hand 

corner of the Template Editor window. 
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Processing the Completed Hospital Stay Evaluations 

Now that you have created the form template for the Hospital Stay Evaluation survey, you are ready 

to begin processing the completed forms using the supplied image Files.   

 

To open the Hospital Stay Evaluation form template 

1. If not already running, start the Remark Office OMR Data Center (Start|Programs|Remark Office 

OMR|Remark Office OMR Data Center). When the Data Center opens, it displays a blank 

spreadsheet-style data grid. The Data Center offers a Task Pane on the left containing the most 

commonly requested actions.  

2. Select the File menu and then click Open Template or select the Open Other templates link in 

the Task Pane. You must open a form template in order to process forms. 

Tip: When you are in the Remark Office OMR Template Editor with a form template 
open, you can select File|Launch Remark Office OMR and the Data Center opens with 
the selected form template also open. 

3. Select the Tutorial2.omr File (the File you created in the previous section of this tutorial) and 

then click the Open button. Alternatively, we have provided a sample File in \Documents\Remark 

Office OMR\Tutorials\Tutorial 2\Remark Office OMR Tutorial 2 – Sample Survey.omr. 

When the Tutorial2 form template opens, its name appears on the title bar at the top of the screen 

and you see the region names you specified as your column headers in the data grid. Each column in 

the grid corresponds with one variable or question in the form template, as the column headers 

indicate. The data grid fills row by row as your completed forms are processed. Each grid row contains 

information from one processed form regardless of the number of Pages the form contains.  

 

To read forms from image Files 

The Read window is used to process completed forms and produce data. The Read window has 

several steps to help customize the reading process. This tutorial focuses on the basic functions. As 

mentioned previously, we are reading pre-scanned image Files. 

 

1. Select the Tools menu and then click Read, or select 

the Read link in the Task Pane.  

The Read window appears.  

2. In the Data Collection Method area, select the 

button for Read Images. 

3. Click the Next button to continue. 

The Image Selection window appears to enable you to 

view and select the images you want to process. 
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4. Navigate to the Tutorial 2 folder of your 

Remark Office OMR installation (e.g. C:\My 

Documents\Remark Office 

OMR\Tutorials\Tutorial 2). 

5. Navigate to the Images for Processing folder.  

6. Select the File called Tutorial 2 – Completed 

Hospital Surveys.tif by either double clicking it 

or selecting it and clicking the top green button 

for Add Selected Images, which moves the File 

into the Images in Read Order window on the 

right.  

7. Click the Next button to continue. 

The Review Exceptions window appears. This 

window allows you to configure options for 

reviewing exception cases such as blank and 

multiple responses. We are using this feature in this tutorial.  

8. If the Enable Review Exceptions button is selected, click it to deselect this option. We are not 

reviewing exceptions at this time. 

9. Click the Read button to begin reading image Files. 

As each image is processed, a row of data is added to the data grid.  

Reviewing and Correcting the Data 

After the forms are processed, 20 rows of data are displayed in the data grid. Each row represents the 

responses collected from one of the forms. You are now ready to inspect the data for missing or 

unrecognized responses in order to prepare for analysis and/or data export.   

We use an automated tool called Review Exceptions to locate and correct any exceptions in our data. 

1. Click the Tools menu and then select Review Exceptions, or click the Review Exceptions link in 

the Task Pane. 

2. Once you access Review Exceptions, use the task pane to select the exception cases you would 

like to review: Blank responses, Multiple Responses, Recognition Errors, Image Regions, Database 

Lookup Regions, Barcode Regions, OCR Regions, Repeated Rank Responses or Required Items. 

You can also choose whether to search by rows or columns in the data grid. 

3. Click the NEXT button at the top of the data grid to start the review process. 

The Data Center searches the data for the specified exception cases. When a selected exception case 

is found, it appears in the data header bar at the top of the data grid. The bar is color coded to match 

the exception type (e.g. yellow for a BLANK response). Use this window to make changes. You can use 

the drop-down list if applicable, or type a response. Note if there is a list of answer choices defined, as 

you begin typing, Remark Office OMR will attempt to auto-fill your answer based on your possible 

answer choices.  

The first piece of flagged data is a multiple response in the first grid row for the item called Length of 

Stay, which is flagged as green in the data header bar.  
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4. In the data header bar above the grid use the 

drop-down list to select the appropriate 

response. Use the Image Viewer beneath the 

data grid to review the respondent’s form. It 

appears that the respondent changed his 

response from 3 to 4 by crossing out the 

original mark and filling in a second bubble. 

We will assume that 4 is the correct response. 

Select 4 from the drop-down list. 

5. Click the NEXT button to move to the next 

exception. Or, simply press Enter. 

6. The next exception is a multiple response in 

row two for the item called Respect. Look at the 

Image Viewer to see the intended response. In 

this case, it looks like the respondent changed 

his response from Strongly Agree to Agree. 

Select Agree from the drop-down list (or type 

“A” and watch Remark Office OMR auto-fill the 

response). 

7. Press the Enter key. There are no more exception cases in the data. 

8. When prompted, click Save Changes to the message to save your changes. There are no more 

exceptions to review in this data set. 

Your data is now ready to be saved and analyzed. 

Saving the Hospital Stay Evaluation Data 

After reviewing the data, you may save it one of many File formats available for exporting data to 

other applications. For this tutorial, we will save the data to the Remark Extended (RMX) format, which 

is a proprietary format within the software. This format saves the exception colors (if any are present) 

as well as the link from the data to the stored images so that you can open your data and still view 

the image that corresponds with any piece of data. 

 

To save the Hospital Stay Evaluation data 

1. Select the File menu and then click Save Data, or click the Save Data link in the Task Pane. 

2. Data can be saved anywhere on your system. By default, a Data folder is installed in the Remark 

Office OMR directory; we recommend using this folder for storage of data Files. In the Look in 

box, navigate to this Data folder on your system (e.g. \Documents\Remark Office OMR \Data). 

3. Click the Save as type down arrow to display a list of File types. 

4. If not already selected, click the Remark (.RMK) format. 

5. Type Tutorial2 in the box titled File name. 

6. Click the OK button to save the File. 
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Analyzing the Hospital Stay Evaluation Data 

Remark Office OMR provides statistical analysis functionality for tabulating data from your forms. The 

Quick Survey feature is one such facility and provides you with a choice of standard reports based on 

your data.  

 

To tabulate the Hospital Stay Evaluation data 

1. Select the Tools menu, then click 

Analysis and then click Quick Survey, or 

click the Analysis tab and then select the 

Quick Survey link in the Task Pane. 

The Remark Quick Stats window appears.  

2. By default, the Condensed Item 

Analysis Report displays. If you are not 

seeing this report, click the Item 

Analysis Reports link in the Task Pane 

and choose Condensed Item Analysis. 

The Condensed Item Analysis Report 

shows several statistics for each question, such as Label, Total and Percent. Each table displays 

statistics for a separate question in the survey. This simple, straightforward report may be all that you 

need to communicate your survey’s results. Although we will not view every available report in this 

tutorial, we suggest that you explore the other available reports and experiment with the report 

options by using the Report Style pane to adjust the look and feel of the reports. 

Let’s take a look at one more report: The Response by Item report, which shows us the answers to the 

“Comments” question. 

 

To run a Response Report by Item report 

1. In the Task Pane, select the Response Reports link and 

click the Response by Item link.  

2. A selection window appears, allowing you to choose 

questions on which to base the report. From the 

Questions list, choose the Comments question and 

move it to the Selected questions window so that we 

can see the responses to our open ended comments 

question. 

3. Click the Run Report button to run the report. 

Notice that the comments are displayed on screen for all 

handwritten comments. You can read through them and/or 

export them to another format. The Report Style pane on 

the right allows you to choose whether to show or hide the 

respondent identifier. Our survey is anonymous; therefore 

you may wish to hide the respondent identifier by changing 
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Respondent ID to No. Then click the Apply button and run the report again. Note that the 

comments are clearer when printed. 

Creating a Report Batch 

The previous tutorial on test grading explored Remark Quick Stats. In this tutorial, we demonstrate 

use of the Report Batch feature. This feature allows you to display, print or export multiple reports at 

one time. In addition, it allows you to auto filter data based on one or more questions on your form. 

We are going to auto filter the data based on the Hospital OCR region. Remark Quick Stats provides 

us with a report for each hospital based on the filter that we set up. 

 

To run a Report Batch  

1. In Remark Quick Stats, select the Tools menu and 

then click Report Batches, or select Report Batches 

from the Task Pane. 

2. Mark the checkbox for Filter Reports by and select 

Hospital. The reports will be created based on the 

hospital names in our data. Remark Quick Stats will 

sort the data behind the scenes and then report by 

hospital.  

3. Click the Next button to continue. 

4. The next window allows you to choose which 

reports to run. Select the Detailed Item Analysis 

Report and the Response Report by Item. These 

reports will provide us with an item analysis for each 

question and a listing of the open-ended comments.  

5. Click the Next button to continue. 

6. The next window allows you to print the reports. We 

will not print for this tutorial. 

7. Click the Next button to continue. 

8. The next window allows you to display and export 

reports. Mark the checkbox for Display the reports 

upon completion. 

9. Mark the checkbox for Export reports as and 

choose Portable Document Format (PDF). Do not 

mark the checkboxes for Merge all selected 

reports into a single File. The result will be 

individual reports for each hospital.  

10. Click the ellipsis next to Base File name to choose a 

location and name for your File. Note where you 

save the File so that you can view it later (you may 

wish to save it to the tutorial folder in 

\Documents\Remark Office OMR\Tutorials\Tutorial 2).  
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11. Click the Finish button to generate the reports. You are asked if you want to save the report 

batch File for later use. Click No for this tutorial (saving report batches is useful if you plan to run 

the same reports repeatedly). 

The reports begin to generate and you see a progress bar on the screen.  

12. The Response Report by Item requires user input. You are prompted to choose the question on 

which to base this report. When prompted, choose the Comments question from the Questions 

window. Use the arrow to move it to the Selected questions window. This report displays all of 

the handwritten comments from the forms. 

You are notified when the Report Batch is finished creating your reports. Navigate on your computer 

to the folder in which you saved the PDF Files. You will see folders for each hospital, and two reports 

in each folder: one for the Detailed Item Analysis and one for the Response Report by Item. If you 

have the Adobe Acrobat Reader, open the reports to gain a better understanding of how the auto 

filter feature worked. 

Tutorial II Summary  

The second tutorial illustrated the basics of using the software, including: 

• Creating a form template 

o Linking OMR regions 

• Processing forms 

• Using Review Exceptions to clean data 

• Saving data 

• Tabulating surveys with Quick Survey 

o Using Report Batches 

 

You have completed the Remark Office OMR tutorials. We encourage you to read the Designing 

Scannable Forms chapter of your Remark Office OMR user’s guide before you get started with your 

own forms. 
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